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前書き

ビジネスルールおよびプロセス開発者は、Business Central でケース管理アセットを使用し、予測不可
能なアドホックケースプロセスを作成できます。ケースワーカーまたはプロセス管理者も、ケース管理
および実行に Business Central を使用できます。Red Hat Process Automation Manager は、参考用と
して、Business Central 内に、ビジネスアセットサンプルを含むサンプルプロジェクトを提供していま
す。本書では、Business Central に同梱されている IT_Orders サンプルプロジェクトをもとに、IT 注文
プロジェクトのサンプルを作成して、テストする方法を説明します。

前提条件前提条件

Red Hat JBoss Enterprise Application Platform 7.2 がインストールされている。詳細情報は
『Red Hat JBoss Enterprise Application Platform 7.2 インストールガイドインストールガイド』を参照してくださ
い。

Red Hat Process Automation Manager がインストールされ、KIE Server で設定されている。詳
細は、『Red Hat JBoss EAP 7.2 へのへの Red Hat Process Automation Manager のインストールのインストール
および設定および設定』を参照してください。

Red Hat Process Automation Manager が実行し、kie-server、user、admin、admin ロールで
Business Central にログインできる。

前書き前書き
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第1章 ケース管理
ケース管理は、Business Process Management (BPM) の拡張機能で、適用可能なビジネスプロセスを
管理します。

BPM は、反復可能で共通のパターンを持つタスクの自動化に使用する管理プラクティスで、プロセス
を完全化して最適化を図ることに焦点を当てます。ビジネスプロセスは通常、ビジネスの目標へのパス
を明確に定義し、モデル化されています。これには、通常量産原理をもとに、多くを予測ができる必要
があります。ただし、実際のアプリケーションの多くは、最初から最後まで完全に記述できません (考
えられるパス、偏差、例外など)。特定のケースでプロセス指向のアプローチを使用すると、複雑なソ
リューションとなり、管理が困難になります。

推測可能なルーチンタスクを対象とする BPM の効率指向アプローチとは対照的に、ケース管理は反復
なしで推測不可能なプロセスに対して問題解決を提供し、プロセスが事前に予測不可能な場合など、一
回限りの状況を管理します。ケースの定義は通常、疎結合プロセスの断片で構成されており、このよう
な断片を直接または間接的に結合して、ランタイム時に発生する変化に対応し、プロセスを動的に管理
しつつ、特定のマイルストーンや最終的なビジネス目標に到達できるようになっています。

Red Hat Process Automation Manager のケース管理には、以下のコアプロセスエンジン機能が含まれ
ます。

ケースファイルのインスタンス

ケースごとのランタイム戦略

ケースコメント

マイルストーン

ステージ

アドホックフラグメント

動的タスクおよびプロセス

ケース識別子 (相関キー)

ケースのライフサイクル (閉じる、再開、キャンセル、破棄)

ケース定義は常にアドホックのプロセス定義で、明示的な開始ノードは必要ありません。ケース定義
は、ビジネスユースケースの主なエントリーポイントです。

プロセス定義は、ケースでサポートされる構成概念として導入され、ケース定義に指定された通り、ま
たは必要に応じて追加処理に動的に取り込むために呼び出すことができます。ケース定義は、以下の新
しいオブジェクトを定義します。

アクティビティー (必須)

ケースファイル (必須)

マイルストーン

ロール

ステージ

Red Hat Process Automation Manager 7.7 ケース管理の使用ガイドケース管理の使用ガイド
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1.1. ケースファイル

ケースインスタンスは、ケース定義を含む 1 つのインスタンスで、ビジネスコンテキストをカプセル化
します。ケースインスタンスデータはすべてケースファイルに保存され、特定のケースインスタンスに
参加する可能性のあるすべてのプロセスインスタンスからアクセスできます。各ケースインスタンス
と、ケースインスタンスのケースファイルは、他のケースから完全に分離されています。ケースインス
タンスの参加者のみがケースファイルにアクセスできます。

ケースファイルは、ケースインスタンス全体のデータリポジトリーとして、ケースの管理に使用しま
す。このファイルには、全ロール、データオブジェクト、データマップなどのデータが含まれます。
ケースを完了してから、同じケースファイルを添付して、後日再度開くことができます。ケースインス
タンスはいつでも終了でき、特別な解決策を提示して完了する必要はありません。

ケースファイルには、埋め込み型のドキュメント、参考資料、PDF 添付ファイル、Web リンクなどの
オプションも含めることができます。

Case ID prefix は、設定可能な接頭辞 (オプション) で、別のタイプのクラスと簡単に区別できるように
します。この接頭辞の後に、ID-XXXXXXXXXX 形式の、生成 ID が続きます。XXXXXXXXXX は、ケー
スインスタンスに一意の ID を指定できるように生成された番号に置き換えてください。接頭辞が指定
されていない場合には、デフォルトの接頭辞 CASE と以下の識別子が使用されます。

CASE-0000000001

CASE-0000000002

CASE-0000000003

接頭辞は、任意で指定できます。たとえば、IT の接頭辞を指定する場合には、次の識別子が生成されま
す。

IT-0000000001

IT-0000000002

IT-0000000003

1.2. コメント

ケース管理では、コメントを使用すればケースインスタンス内での協業作業が容易になり、簡単にケー
ス作業者が互いに情報を交換できるようになります。

コメントはケースインスタンスにバインドされます。ケースインスタンスはケースファイルの一部であ
るため、コメントを使用してインスタンスに対してアクションを実行できます。基本的なテキストベー
スのコメントには、CRUD (作成、読み取り、更新、削除) と同様の完全な操作セットを含めることがで
きます。

1.3. ケースロール

ケースロールは、ユーザーがケース処理に参加する追加の抽象層を提供します。ロール、ユーザー、グ
ループは、ケース管理の別の目的に使用されます。

ロールロール

ロールは、ケースインスタンスの認証や、ユーザーアクティビティーの割り当てを可能にします。
所有者ロールには、ユーザーまたは 1 つ以上のグループを割り当てることができます。ケースが所属
するユーザーが所有者です。ケースの定義では、ロールの割り当てはユーザーまたはグループ 1 つだ

第第1章章 ケース管理ケース管理
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けに制限されません。特定のユーザーまたはグループにタスクを割り当てる代わりに、ロールを使
用してタスクの割り当てを指定することで、ケースを動的に保ちます。

Groups

グループとは、特定のタスクを実行できるユーザー、または指定の責任が割り当てられたユーザー
の集合です。グループには何人でも割り当てることができ、ロールにはどのグループでも割り当て
ることができます。グループのメンバーは、いつでも追加または変更できるので、特定のタスクに
グループをハードコード化しないでください。

Users

ユーザーとは、ロールに割り当てたり、グループに追加したりして、特定のタスクを割り当てるこ
とができる個人を指します。

以下の例では、前述のケース管理の概念をホテル予約にどのように適用するかを説明します。

ロール = Guest

グループ = Receptionist、Maid

ユーザー = Marilyn

Guest のロールを割り当てると、関連ケースの特定の作業に影響があり、ケースインスタンスごとに固
有です。ロールに割り当てることができるユーザーまたはグループの数は Case Cardinality で制限さ
れています。Case Cardinality は、プロセスデザイナーのロール作成時に設定されます (例: ホテル予約
ケースではゲストロールが 1 つ、IT_Orders サンプルプロジェクトでは IT ハードウェア業者ロールが 2
つです)。

ロールが定義されている場合には、ロールがケース定義の一部としてユーザー 1 人またはグループ 1 つ
にハードコードされておらず、ケースインスタンスごとに違うものを指定できるようにする必要があり
ます。ケースのロール割り当てが重要なのは、このような理由からです。

ロールは、ケースの開始時や、ケースがアクテイブになった時点で割り当てまたは割り当ての解除がで
きます。ロールはオプションですが、ケース定義でロールを使用して、整理されたワークフローを維持
します。

重要重要

タスク割り当てに実際のユーザーまたはグループ名を使用する代わりに、ロールを使用
します。これにより、必要に応じて、ユーザーまたはグループを実際に動的に割り当て
るタイミングを遅らせることができます。

ロールはユーザーまたはグループに割り当てられ、ケースインスタンスの起動時にタスクを実行する権
限があります。

Red Hat Process Automation Manager 7.7 ケース管理の使用ガイドケース管理の使用ガイド
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第2章 IT_ORDERS サンプルプロジェクトの確認
独自のケース管理プロジェクトを作成する前に、Business Central で既存の IT_Orders サンプルケース
管理プロジェクトを確認してください。このサンプルプロジェクトには、独自のケースプロジェクトの
リファレンスとして、事前定義されたケース管理アセットが含まれています。

重要重要

ビジネスプロセスアプリケーションサンプルには、テクノロジープレビューとして提供
されている機能が含まれます。テクノロジープレビュー機能は、Red Hat 製品のサービ
スレベルアグリーメント (SLA) ではサポートされていません。機能的に完全でない可能
性があり、Red Hat では実稼働環境での使用を推奨しません。テクノロジープレビュー
機能は、近々発表予定の製品機能をリリースに先駆けてご提供することにより、お客様
に機能性をテストしていただき、開発プロセス中にフィードバックをお寄せいただくこ
とを目的としています。Red Hat テクノロジープレビュー機能の詳細は「テクノロジプ
レビュー機能のサポート範囲」を参照してください。

手順手順

1. Business Central で、Menu → Design → Projects に移動します。既存のプロジェクトがある場
合には、MySpace のデフォルトのスペースをクリックして、Add Project プルダウンメニュー
から Try Samples を選択して、サンプルにアクセスできます。既存のプロジェクトがない場合
には、Try samples をクリックします。

2. IT_Orders を選択し、OK をクリックします。

プロジェクトの Assets ビューが開きます。各サンプルアセットを選択し、特定の目的またはワークフ
ローを達成するためにどのようにプロジェクトが設計されているか確認します。

orderhardware Business Processes アセットを確認します。これはビジネスプロセスフローを理解す
るのに役立ちます。

注記注記
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注記注記

Business Central のレガシーのプロセスデザイナーは、Red Hat Process Automation
Manager 7.7.0 で非推奨になりました。このデザイナーは、今後の Red Hat Process
Automation Manager のバージョンで削除予定です。そのため、レガシーのプロセスデザ
イナーには新しい機能拡張や機能は追加されません。レガシーのプロセスデザイナーの
既存ユーザーは、プロジェクトを新しいデザイナーに移行してください。プロジェクト
の新規デザイナーへの移行に関する詳細は、『Business Central におけるプロジェクトの
管理』を参照してください。
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第3章 新しい IT_ORDERS ケースプロジェクトの作成
Business Central で新しい IT_Orders プロジェクトを作成して、必要なすべてのアセットとプロジェク
トでの使用方法を理解します。

手順手順

1. Business Central にログインし、Menu → Design → Projects の順に移動します。
Business Central は以下のイメージのように MySpace と呼ばれるデフォルトスペースを提供し
ます。このデフォルトスペースを使用してサンプルプロジェクトを作成およびテストできま
す。

図図3.1 デフォルトスペースデフォルトスペース

2. Add Project → Case project をクリックします。

図図3.2 ケースプロジェクトメニューケースプロジェクトメニュー

3. Name フィールドに IT_Orders_New と入力します。

4. 追加追加 をクリックします。

図図3.3 Add Project ウインドウウインドウ

第第3章章 新しい新しい IT_ORDERS ケースプロジェクトの作成ケースプロジェクトの作成
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図図3.3 Add Project ウインドウウインドウ

プロジェクトの Assets ビューを開きます。
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第4章 データオブジェクト
データオブジェクトは、作成するルールアセットの構成要素です。データオブジェクトは、プロジェク
トで指定したパッケージに Java オブジェクトとして実装されているカスタムのデータ型です。たとえ
ば、データフィールド Name、Address、および Date of Birth を使用して Person オブジェクトを作
成し、ローン申し込みルールに詳細な個人情報を指定できます。このカスタムのデータ型は、アセット
とディシジョンサービスがどのデータに基づいているかを指定します。

4.1. ITORDERSERVICE データオブジェクトの作成

ITOrderService データオブジェクトは、IT Orders 変数の定義に使用されるデータタイプを指定しま
す。

前提条件前提条件

IT_Orders_New プロジェクトが作成されます。

手順手順

1. Add Asset → Data Object をクリックします。

2. Create new Data Object ウィザードで、次の値を入力します。

Data Object: ITOrderService

Package: com.myspace.it_orders_new

3. OK をクリックします。

4. Package プルダウンメニューの横にある  をクリックして、データオブジェクトの新しい
パッケージを指定します。

5. org.jbpm.demo.it_orders.services と入力し、Add をクリックします。

6. Save をクリックした後、Yes, Move をクリックして変更を確認します。

4.2. SURVEY データオブジェクトの作成

Survey データオブジェクトには、deliveredOnTime や missingEquipment. などのデータフィールドが
含まれています。ケースの設計時に、そのデータと値を使用します。

前提条件前提条件

IT_Orders_New プロジェクトが作成されます。

手順手順

1. Business Central にログインし、Menu → Design → Projects の順にクリック
し、IT_Orders_New をクリックします。

2. Add Asset → Data Object をクリックします。

3. Create new Data Object ウィザードで以下の値を入力します。

第第4章章 データオブジェクトデータオブジェクト
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Data Object: Survey

Package: com.myspace.it_orders_new

4. OK をクリックします。

5. Survey データオブジェクトの制約を追加します。

a. add field をクリックします。

b. 以下の値を入力します。

Id: comment

Label: 入力しない

Type: String

c. Create and continue をクリックしてから、以下の値を入力します。

Id: deliveredOnTime

Label: 入力しない

Type: Boolean

d. Create and continue をクリックしてから、以下の値を入力します。

Id: missingEquipment

Label: 入力しない

Type: String

e. Create and continue をクリックしてから、以下の値を入力します。

Id: satisfied

Label: 入力しない

Type: Boolean

f. Create をクリックします。

6. Save をクリックして、変更を確定します。

図図4.1 Survey データオブジェクトの詳細データオブジェクトの詳細
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第5章 ケース定義の設計
Business Central のプロセスデザイナーを使用してケースを設計できます。ケース設計は、ケース管理
に基づいて、各ケースに固有の目的およびタスクを設定します。ケースフローは、動的タスクまたはプ
ロセスを追加して、実行時に動的に変更できます。この手順では、同じケース定義を作成して、ケース
定義設計プロセスを学びます。

Business Central の IT_Orders サンプルプロジェクトには次の orderhardware ビジネスプロセスケー
ス定義が含まれています。

図図5.1 orderhardware ビジネスプロセスケース定義ビジネスプロセスケース定義

前提条件前提条件

Business Central で新しいケースを作成している。詳細については、3章新しい IT_Orders ケー
スプロジェクトの作成 を参照してください。

データオブジェクトを作成している。詳細については、4章データオブジェクト を参照してく
ださい。

手順手順

1. Business Central にログインし、Menu → Design → Projects の順にクリック
し、IT_Orders_New をクリックします。

2. Add Asset → Case Definition の順にクリックします。

3. Create new Case definition ウィンドウで、次の必要な情報を追加します。

Case definition: orderhardware を入力します。これは通常、ケース管理されているケース
またはプロジェクトの主題です。

Package: com.myspace.it_orders_new を選択して、ケースファイルの作成場所を指定し
ます。

4. OK をクリックしてプロセスデザイナーを開きます。
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5. ケース内で使用されるサブプロセス、サブケース、およびビジネスルールにアクセス可能な
ケースファイル変数に値を定義します。

a. 右上の Diagram properties  アイコンをクリックします。

b. 下方向にスクロールして Case Management を展開し、Case File Variables セクションの

 をクリックして、次の値を入力します。

図図5.2 orderhardware ケースファイル変数ケースファイル変数

注記注記

次のケースファイル変数は、カスタムのデータ型です。

hwSpec: org.jbpm.document.Document (この値の型)

survey: Survey [com.myspace.it_orders_new] (この値を選択)

6. Save をクリックします。

7. ケースに関係するロールを定義します。

a. 右上の Diagram properties  アイコンをクリックします。

b. 下方向にスクロールして Case Management を展開し、Case Roles セクションの  を
クリックして、次の値を入力します。

図図5.3 orderhardware ケースロールケースロール
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図図5.3 orderhardware ケースロールケースロール

owner: ハードウェア注文リクエストを行う従業員。ロールの基数は 1 に設定します。
これは、このロールに割り当てるユーザーまたはグループが 1 つであることを示してい
ます。

manager: 従業員のマネージャー。リクエストされたハードウェアを承認または却下す
る担当者。ロールの基数は 1 に設定します。これは、このロールに割り当てるユー
ザーまたはグループが 1 つであることを示しています。

supplier: システム内の IT ハードウェアの利用可能なサプライヤー。ロールの基数は 2
に設定します。つまり、このロールに複数のサプライヤーを割り当てることができま
す。

8. Save をクリックします。

5.1. PLACE ORDER サブプロセスの作成

Place order サブプロセスを作成します。これは、別のビジネスプロセスで、サプライヤーが実行しま
す。このサブプロセスは、5章ケース定義の設計 で説明されているように、ケースの実行中に発生する
再利用可能なプロセスです。

前提条件前提条件

Business Central で新しいケースを作成している。詳細については、3章新しい IT_Orders ケー
スプロジェクトの作成 を参照してください。

データオブジェクトを作成している。詳細については、4章データオブジェクト を参照してく
ださい。

手順手順

1. Business Central にログインし、Menu → Design → Projects → IT_Orders_New の順にクリッ
クします。

2. プロジェクトメニューから Add Asset → Business Process の順にクリックします。

3. Create new Business Process ウィザードで、以下の値を入力します。

Business Process: place-order

Package: Select com.myspace.it_orders_new

4. OK をクリックすると、ダイアグラムエディターが開きます。
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5. キャンバスの空きスペースをクリックし、右上隅の Diagram properties  アイコンをク
リックします。

6. 下方向にスクロールして Process Data を展開し、Process Variables セクションの  をク
リックして、次の値を入力します。

7. Save をクリックします。

8. 開始イベントをキャバスにドラッグして、開始イベントからタスクに外向き接続を作成し、新
しいタスクをユーザータスクに変換します。
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9. ユーザータスクをクリックし、Diagram Properties パネルの Name フィールドに Place order
を入力します。

10. Implementation/Execution を展開し、Groups メニューで Add をクリックし、さらに Select
→ New をクリックして supplier を入力します。

11. Assignments フィールドの  をクリックし、以下を追加します。
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初めて入力を割り当てる場合は、Data Type に Custom を選択し
て、org.jbpm.document.Document と入力します。

12. Save をクリックします。

13. Skippable チェックボックスを選択し、Description フィールドに次の文字を入力します。
Approved order #{CaseId} to be placed

14. Place order ユーザータスクから外向き接続を作成し、終了イベントに接続します。
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15. Save をクリックして、変更を確定します。

5.2. マネージャー承認のビジネスプロセスの作成

マネージャーの承認プロセスは、注文を受ける否かを決定します。

手順手順

1. Business Central で、Menu → Design → Projects → IT_Orders_New → orderhardware
Business Process の順にクリックします。

2. 「prepare hardware spec」ユーザータスクを作成して設定します。

a. 開始イベントをキャバスにドラッグして、開始イベントからタスクに外向き接続を作成
し、新しいタスクをユーザータスクに変換します。

b. 新規ユーザータスクをクリックして、画面の右上隅の Properties  アイコンをクリック
します。

c. Name フィールドに Prepare hardware spec と入力します。

d. Implementation/Execution を展開し、Groups メニューで Add をクリックし、さらに
Select → New をクリックして supplier を入力します。

e. Task Name フィールドに PrepareHardwareSpec と入力します。

f. Skippable チェックボックスを選択し、Description フィールドに次の文字を入力します。
Prepare hardware specification for #{initiator} (order number #{CaseId})

g. Assignments フィールドの  をクリックし、以下を追加します。
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h. Save をクリックします。

3. 「manager approval」ユーザータスクを作成して構成します。

a. Prepare hardware spec ユーザータスクをクリックして、新しいユーザータスクを作成し
ます。

b. 新規ユーザータスクをクリックして、画面の右上隅の Properties  アイコンをクリック
します。

c. ユーザータスクをクリックし、Properties パネルの Name フィールドに Manager 
approval と入力します。

d. Implementation/Execution を展開し、Actors メニューで Add をクリックし、さらに
Select → New をクリックして manager と入力します。

e. Task Name フィールドに ManagerApproval と入力します。

f. Assignments フィールドの  をクリックし、以下を追加します。

Red Hat Process Automation Manager 7.7 ケース管理の使用ガイドケース管理の使用ガイド

20



g. Save をクリックします。

h. Skippable チェックボックスを選択し、Description フィールドに次の文字を入力します。
Approval request for new hardware for #{initiator} (order number #{CaseId})

i. On Exit Action フィールドに、以下の Java 式を入力します。
kcontext.setVariable("caseFile_managerDecision", approved);

j. Save をクリックします。

4. Manager approval ユーザータスクをクリックして、データに基づく排他的論理和 (XOR) ゲー
トウェイを作成します。
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5. 「place order」の再利用可能なサブプロセスを作成して設定します。

a. Object Library から Subprocesses を展開して、Reusable をクリックします。データに基
づく排他的論理和 (XOR) ゲートウェイの右側のキャンバスに新しい要素をドラッグしま
す。

b. データに基づく排他的論理和 (XOR) ゲートウェイをサブプロセスに接続します。

c. 新規サブユーザータスクをクリックして、画面の右上隅の Properties  アイコンをク
リックします。

d. Name フィールドに Place order と入力します。
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e. Data Assignments を展開し、Assignments フィールドの  をクリックし、以下を追加
します。

f. データに基づく排他的論理和 (XOR) ゲートウェイからサブプロセスへの接続をクリック

し、Properties  アイコンをクリックします。

g. Implementation/Execution を手内して Condition を選択肢、以下の条件式を設定しま
す。

h. Place order ユーザータスクをクリックし、終了イベントを作成します。

6. 「order rejected」ユーザータスクを作成して設定します。

a. データに基づく排他的論理和 (XOR) ゲートウェイをクリックして、新規ユーザータスクを
作成します。

b. 新規タスクを Place order タスクの下に並ぶようにドラッグします。
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c. 新規ユーザータスクをクリックして、画面の右上隅の Properties  アイコンをクリック
します。

d. Name フィールドに Order rejected と入力します。

e. Implementation/Execution を展開し、Task Name フィールドに OrderRejected と入力し
ます。

f. Actors メニューで Add をクリックし、さらに Select → New をクリックして owner と入
力します。

g. Assignments フィールドの  をクリックし、以下を追加します。

h. Save をクリックします。

i. Skippable チェックボックスを選択し、Description フィールドに次の文字を入力します。
Order #{CaseId} has been rejected by manager

j. Order rejected ユーザータスクをクリックし、終了イベントを作成します。

k. Save をクリックします。

7. データに基づく排他的論理和 (XOR) ゲートウェイから Order rejected ユーザータスクへの接

Red Hat Process Automation Manager 7.7 ケース管理の使用ガイドケース管理の使用ガイド

24



7. データに基づく排他的論理和 (XOR) ゲートウェイから Order rejected ユーザータスクへの接

続をクリックし、Properties  アイコンをクリックします。

8. Implementation/Execution を手内して Condition を選択肢、以下の条件式を設定します。

9. Save をクリックします。

図図5.4 マネージャー承認のビジネスプロセスマネージャー承認のビジネスプロセス
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第6章 マイルストーン
マイルストーンとは、プロセスデザイナーパレットにマイルストーンノードを追加して、ケース定義デ
ザイナーで設定できる、特別なサービスタスクのことです。新規ケース定義の作成時に、 Adhoc 
autostart として設定されたマイルストーンは、デフォルトでデザインパレットに含まれます。新規作
成したマイルストーンはデフォルトで Adhoc autostart には設定されません。

ケース管理のマイルストーンは、ステージの最後に発生するのが通常ですが、他のマイルストーンを達
成した結果として発生する場合もあります。マイルストーンには、進捗を追跡するために、条件を定義
する必要があります。マイルストーンは、ケースにデータを追加すると、ケースファイルのデータに反
応します。また、マイルストーンは、ケースインスタンス内の達成地点を表し、特定のイベントにフラ
グを立てるために使用できます。これは、重要業績評価指標 (KPI) の追跡や、完了前のタスクの特定に
有用な場合があります。

マイルストーンには、ケース実行中の以下のいずれのか状態を指定できます。

Active: 条件はマイルストーンで定義されているが、条件がまだ満たされていない。

Completed: マイルストーンの条件が満たされ、達成されたので、このケースは次のタスクに進
むことができる。

Terminated: マイルストーンがケースプロセスから除外され、必要なくなっている。

Adhoc autostart が設定されていて、マイルストーンが使用可能な場合や、完了している場合には、自
動的に、またはシグナルを使用して手動で、ケースインスタンスの開始時に、マイルストーンをトリ
ガーできます。マイルストーンは何回でもトリガーできますが、条件が満たされている場合には、直接
マイルストーンが達成されます。

6.1. HARDWARE SPEC READY マイルストーンの作成

必要なハードウェア仕様書の完成時に到達する HardwareSpecReady マイルストーンを作成します。

手順手順

1. プロセスデザイナーで、Object Library の Milestone を展開し、キャンバスに新しいマイルス
トーンをドラッグして Place order 終了イベントの右側に配置します。

2. 新規マイルストーンをクリックして、画面の右上隅の Properties  アイコンをクリックし
ます。

3. Name フィールドに Hardware spec ready と入力します。

4. Implementation/Execution を展開して Adhoc Autostart を選択します。

5. Data Assignments を展開し、Assignments フィールドの  をクリックし、以下を追加しま
す。
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Source コラムのドロップダウンをクリックし、Constant を選択して 
org.kie.api.runtime.process.CaseData(data.get("hwSpec") != null) と入力します。

6. Save をクリックします。

6.2. MANAGER DECISION マイルストーンの作成

managerDecision 変数に応答が渡されると、このマイルストーンに到達します。

手順手順

1. プロセスデザイナーで、Object Library の Milestone を展開し、HardwareSpecReady マイル
ストーンの下のキャンバスに新しいマイルストーンをドラッグします。

2. 新規マイルストーンをクリックして、画面の右上隅の Properties  アイコンをクリックし
ます。

3. Name フィールドに Manager decision と入力します。

4. Implementation/Execution を展開して Adhoc Autostart を選択します。

5. Data Assignments を展開し、Assignments フィールドの  をクリックし、以下を追加しま
す。
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Source コラムのドロップダウンをクリックし、Constant を選択して 
org.kie.api.runtime.process.CaseData(data.get("managerDecision") != null) と入力しま
す。

6. Save をクリックします。

6.3. ORDER PLACED マイルストーンの作成

このマイルストーンには、Place order サブプロセスの一部である ordered 変数に応答が渡されると、
到達します。

手順手順

1. プロセスデザイナーで、Object Library の Milestone を展開し、Prepare hardware spec ユー
ザータスクの下のキャンバスに新しいマイルストーンをドラッグします。

2. 新規マイルストーンをクリックして、画面の右上隅の Properties  アイコンをクリックし
ます。

3. Name フィールドに Milestone 1: Order placed と入力します。

4. Implementation/Execution を展開して Adhoc Autostart を選択します。

5. Data Assignments を展開し、Assignments フィールドの  をクリックし、以下を追加しま
す。
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Source 列のドロップダウンをクリックし、Constant を選択
し、org.kie.api.runtime.process.CaseData(data.get("ordered") == true) を入力します。これ
は、ordered というケース変数が値 true を持つことを意味します。

6. Save をクリックします。

7. Milestone 1: Order placed をクリックして、新しいスクリプトタスクを作成します。

8. 新規スクリプトタスクをクリックして、画面の右上隅の Properties  アイコンをクリック
します。

9. Name フィールドに Notify requestor と入力します。

10. Implementation/Execution and input System.out.println("Notification::Order placed"); を展
開します。

11. Notify requestor スクリプトタスクをクリックして、シグナル終了イベントを作成します。
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12. シグナルイベントをクリックして、画面の右上隅の Properties  アイコンをクリックしま
す。

13. Implementation/Execution を展開して Signal フィールドの下向き矢印をクリックし、New
を選択します。

14. Milestone 2: Order shipped と入力します。

15. Signal Scope フィールドの下矢印をクリックし、Process Instance を選択します。

16. Save をクリックします。

図図6.1 Order placed マイルストーンマイルストーン

6.4. ORDER SHIPPED マイルストーンの作成

このマイルストーンの条件は、shipped というケースファイル変数が true であることです。このマイ
ルストーンでは、Adhoc autostart は有効になっていませんが、代わりに、注文の送信準備が完了した
時にシグナルイベントによってトリガーされます。

手順手順

1. プロセスデザイナーで、Object Library の Milestone を展開し、Notify requestor スクリプト
タスク下のキャンバスに新しいマイルストーンをドラッグします。

2. 新規マイルストーンをクリックして、画面の右上隅の Properties  アイコンをクリックし
ます。

3. Name フィールドに Milestone 2: Order shipped と入力します。

4. Implementation/Execution を展開して、Adhoc Autostart が選択されていないことを確認し
ます。

5. Data Assignments を展開し、Assignments フィールドの  をクリックし、以下を追加しま
す。
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Source 列のドロップダウンをクリックし、Constant を選択して 
org.kie.api.runtime.process.CaseData(data.get("shipped") == true) を入力します。これ
で、shipped というケース変数に値 true を指定しています。

6. Save をクリックします。

7. Milestone 2: Order shipped をクリックして、新しいスクリプトタスクを作成します。

8. 新規スクリプトタスクをクリックして、画面の右上隅の Properties  アイコンをクリック
します。

9. Name フィールドに Send to tracking system と入力します。

10. Implementation/Execution を展開して、System.out.println("Order added to tracking 
system"); と入力します。

11. Send to tracking system スクリプトタスクをクリックして、シグナル終了イベントを作成しま
す。

12. シグナルイベントをクリックして、画面の右上隅の Properties  アイコンをクリックしま
す。

13. Implementation/Execution を展開して Signal フィールドの下向き矢印をクリックし、New
を選択します。

14. Milestone 3: Delivered to customer と入力します。

15. Signal Scope フィールドの下矢印をクリックし、Process Instance を選択します。

16. Save をクリックします。

図図6.2 Order shipped マイルストーンマイルストーン
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図図6.2 Order shipped マイルストーンマイルストーン

6.5. DELIVERED TO CUSTOMER マイルストーンの作成

このマイルストーンの条件は、delivered というケースファイル変数が true であることです。Adhoc 
autostart はこのマイルストーンに対して有効ではありません。代わりに、注文品が顧客に正常に配送
された後にシグナルイベントによってトリガーされます。

手順手順

1. プロセスデザイナーで、Object Library の Milestone を展開し、Send to tracking system ス
クリプトタスク下のキャンバスに新しいマイルストーンをドラッグします。

2. 新規マイルストーンをクリックして、画面の右上隅の Properties  アイコンをクリックし
ます。

3. Name フィールドに Milestone 3: Delivered to customer と入力します。

4. Implementation/Execution を展開して、Adhoc Autostart が選択されていないことを確認し
ます。

5. Data Assignments を展開し、Assignments フィールドの  をクリックし、以下を追加しま
す。

Source 列のドロップダウンをクリックし、Constant を選択し
て、org.kie.api.runtime.process.CaseData(data.get("delivered") == true) を入力します。こ
れは、delivered というケース変数が値 true を持つことを意味します。

6. Save をクリックします。
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7. Milestone 3: Delivered to customer をクリックして、新しいユーザータスクを作成します。

a. 新規ユーザータスクをクリックして、画面の右上隅の Properties  アイコンをクリック
します。

b. Name フィールドに Customer satisfaction survey を入力します。

c. Implementation/Execution を展開し、Actors メニューで Add をクリックし、さらに
Select → New をクリックして owner と入力します。

d. Task Name フィールドに CustomerSurvey を入力します。

e. Skippable チェックボックスを選択し、Description フィールドに次の文字を入力します。
Satisfaction survey for order #{CaseId}

f. Assignments フィールドの  をクリックし、以下を追加します。

g. Save をクリックします。

8. Customer satisfaction survey ユーザータスクをクリックし、終了イベントを作成します。

9. Save をクリックして、変更を確定します。

図図6.3 Delivered to customer マイルストーンマイルストーン

すべてのマイルストーンシーケンスが完了したら、IT 発注ケースを終了できますが、ケースの特徴とし
て特別対応な面があるので、たとえば、注文した品物が顧客に届かない場合、または欠陥品だった場合
に、ケースを再開できます。ランタイム時でも、タスクを再度発生させたり、必要に応じてケース定義
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に追加したりできます。
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第7章 IT ORDER ケースプロジェクトのデプロイとテスト

前提条件前提条件

Business Central に接続されている実行中の KIE Server がある。詳細は、『Red Hat JBoss
EAP 7.2 へのへの Red Hat Process Automation Manager のインストールおよび設定のインストールおよび設定』を参照して
ください。

Business Central で新しいケースを作成している。詳細については、3章新しい IT_Orders ケー
スプロジェクトの作成 を参照してください。

データオブジェクトを作成している。詳細については、4章データオブジェクト を参照してく
ださい。

Place order サブプロセスを作成している。詳細については、「Place order サブプロセスの作
成」を参照してください。

Order for IT ハードウェアケースを設計している。詳細については、5章ケース定義の設計 を参
照してください。

手順手順

1. Business Central にログインし、Menu → Design → Projects の順にクリック
し、IT_Orders_New をクリックします。

2. デプロイデプロイ をクリックします。

3. Menu → Manage → Process Definitions → Manage Process Instances → New Process
Instance の順にクリックします。

4. Menu → Deploy に移動し、Execution Servers をクリックし、新しいコンテナーがデプロイさ
れ、起動されていることを確認します。

5. Case Management Showcase アプリケーションを使用して新規ケースインスタンスを開始しま
す。Showcase アプリケーションの使用方法は、『ケース管理へのケース管理への Showcase アプリケーショアプリケーショ
ンの使用ンの使用』を参照してください。
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第8章 関連資料
『ケース管理の設計および構築ケース管理の設計および構築』

『ケース管理へのケース管理への Showcase アプリケーションの使用アプリケーションの使用』

『ビジネスプロセスの使用ガイドビジネスプロセスの使用ガイド』
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